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Building Systems Design

LinkLine

CostLink/CM "’s Alternate Hierarchies
- sort your data to suit your needs

One of the most powerful tools in BSD
CostLink/CM, BSD’s premiere cost
engineering tool, is its support of multiple
hierarchies (Work Breakdown
Structures or WBS's) within the same
project. You typically build your estimate
using the default Project WBS View.
The Project WBS can be user defined
or selected from a template, and this
view generally reflects overall project
organization for estimating purposes.
CostLink/CM then allows you to create
any number of additional hierarchies
within your estimate into which you can
then reorganize your costs.

For a typical building construction
project, the Project WBS hierarchy
might be by building number and then

by Uniformat system (Substructure,
Superstructure, Exterior, etc.). For
environmental projects, the WBS might
be by site or location, and then by type
of remediation. Any hierarchy can
include hundreds, or even thousands of
‘folders’ or summary elements for
reporting, tiered to as many as 80 levels.
CM supports up to six levels in standard
reports. Custom reports can be created
to add additional levels of reporting.

In addition to the standard Project WBS
View, CostLink/CM also provides a Bid
Schedule View and a Project CSI View
as alternate standard views. This
powerful feature allows you to easily
build and maintain multiple cost
summary structures simultaneously. As

See Hierarchies, page 2

ol D Dokl ko T
Fle Edl Yew Gesmacsd Jies |ried Took jpfedoss el
DFe G- + M IRB X gD ®&a&EmM
[fmm GRS RS2y ML ENS SR
[ Rl T Ty e— [=]
[Sbe Schesba B g 175 e
e | [Ty |
Toatul Propmct T cdal Froct
| Sl F e i | FET LI | | TSy S AT = You can IO,Ok
= 2 Siw o Bulding Shel $2167 288 = £3 Eusidng Coegirection £ AR at your project
= 0 Sabwmahas 1355 4 [ Pyl Lie Dok 2 M0 in A
= 23 Supmiractus a0 B 7B ubrinchue STESM _In dlffere_nf
5153 Enbim Dt M7 HED Supeincas:  BHEOTIT views by tiling
= =1 Reoirg 1153 BEA 51 1 pharca Clons TF I .
T 5058 1B Fookg e them side by
O Corar Fusradusd £ Lo 5 £ ke Carote, SUFE side.
sapdwonne s gl dSmwmmee  pmim g
[ Semace Tag [mscran [SoaceTag Omcwpbon
[=3{] | 6 e ] B g el 1= Bopiederg L orebucion
I 2 [=1H 3 Lk Fi O (=3[ T
Ol |Ca (wrem’ Frprashrd Ecpaparand
4] | Eflald LI |
Ehwd pariigred 01 Taks I

Spring 2000

BSD Support Staff

the crew that keeps you working

[ R -

Whose voice is it on the other end of
the line when you have a pressing
problem? Most likely it's Beth, Laurie,
or Rick, members of the BSD Support
and Training group. This fine group has
an in-depth knowledge of all BSD
commercial and government products
and how they are used in our customers’
businesses. They can explain not only
the nuts and bolts of how the software
works but also the finer points that can
make you more efficient.

“quick response times and
dependability have been
invaluable”

All new users have two coupons in-
cluded in their initial software pack. The
first coupon is for a 30-minute introduc-
tion to their new software product. Just
call technical support and schedule a
time that is convenient for both of you.
Try to pick a time when you have 30
quiet, uninterrupted minutes so you can
really concentrate on the new things you

See Support, page 5
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Hierarchies
continued from page 1

you build your estimate in the Project
WBS View, the tasks you add to your
estimate are automatically added to all
other views. Until the tasks are assigned
to folders in the other hierarchies, they
will be located in an ‘Unassigned’ folder
at the foot of the hierarchy tree.
However, every task is always
represented and totaled in each
hierarchy so that all hierarchies total to
the same project cost.

Example

You may need to organize your project
by a Systems breakdown for a certain
client, but that same client would also
like to see the costs broken down by CSI
divisions. The easiest way to do this
would be to start your estimate using
the supplied Uniformat template. After
copying tasks from the CostBook into
the appropriate folders in the Project
WBS View in your project, you would
then use the Assign Tasks to CSI
function to automatically assign the
tasks to the appropriate folder in the
Project CSI View. The software will
automatically place each task in the
appropriate folder in the Project CSI
View based on the CSI tag used by the
source CostBook.

The default CSI hierarchy provides
Division-level folders at level one, but if
you would like further breakdown, you
can simply add the next level of CSI
folders to your template. The ‘Assign
to CSI' command will then sort the tasks
into the level 2 CSI folders again using
the CostBook tag to identify the related
folder. You can choose which hierarchy
to use for a given set of reports. You
can switch between reported hierarchies
in the Report Setup dialog and easily
run a new set of reports at any time.

User-Defined Hierarchies

In addition to providing multiple standard
hierarchies that you can modify and
expand, CM also lets you create, copy
and modify your own user-defined
hierarchies. If your accounting
department needs to see the costs
broken down by specific accounting
codes, you can easily create a separate
accounting code hierarchy and cross-
reference all or any part of your estimate

to the code of accounts. Or maybe you
want to relate the estimate to the
construction schedule, or reorganize to
match a historical cost analysis system,
or identify cost elements for take-off
using a hierarchical list of project
drawings. All of these are candidates
for use of user-defined hierarchies.

To create a new hierarchy, you simply
click on the Insert menu and choose
Hierarchy. Once you provide a
hierarchy name, you can add folders in
a number of ways. Hierarchy folders
(representing accounts in our example)
can be added individually or easily
copied from another project or hierarchy
template using drag and drop, or copy-
paste. Once the folder structure is in
place, the easiest way to assign the
tasks to the appropriate folder in this
hierarchy is to open a new window in
the same project and drag and drop
folders and/or tasks from the Project
WBS View into the new hierarchy. You
can also drag items from the unassigned
folder. Moving items is as simple as
dragging from one folder to another.
The unique technology makes it
impossible to accidentally duplicate
items or leave items out entirely. Iltems
will always appear in the Unassigned
folder if nowhere else

Again, you can print reports using your
new user-defined hierarchy. Your
reports can also be exported into an
Excel spreadsheet, or any of more than
a dozen other formats, one of which may
be preferred by your accounting
department (or other customer) than
another paper report!

BSD CostLink/CM (M32)

Does CostLink/CM handle
negative numbers? What about
Metric units?

Of course. To enter a negative

number, just type the negative
sign directly preceding the number en-
try. You can add cost items to your
project either by dragging from a data-
base or by direct entry, and the Units of
Measure can be either English or Met-
ric or a combination of both.

Is there an easy way to compare
estimated costs and actual costs?

One nice feature of CostLink/CM

is its ability to export estimate
costs to an Excel spreadsheet. Make a
copy of your estimate and enter in the
final project costs. Then export both
project reports to Excel; this is typically
done at a meaningful folder level. Once
the costs are in Excel you can use its
full capabilities to analyze your data.

Warning: Some people who have
recently loaded the latest edition
of Primavera Expedition have tempo-
rarily disabled CM. If this happens to

See Q&A, page 5
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About your SpecLink Update

BSD SpecLink Statistics:

725 sections total

425 non-proprietary sections

300 proprietary sections (15 new sections )
1191 external documents referenced

165 standards developing organizations
2155 building product manufacturer listings

New Sections:

07315 - Slate Shingles

(Echeguren Slate from around the world)

08450 - All-Glass Entrances and Storefronts

(DORMA Glas, swinging, sliding, and folding)

08635 - High-Performance Translucent Skylights
(Skywall Advanced Translucent System)

08713 - Door Closers

(LCN, standard and combination closer/holders)

08746 - Low-Energy Door Operators

(LCN, pneumatic and electric)

09227 - Exposed Aggregate Pool Finish

(SGM, Diamond Brite, River Rok, and Durrazzo)

09900 - Paints and Coatings (Martin Senour Paint)
09900 - Paints and Coatings (Pratt & Lambert Paint)
09982 - Cementitious Coatings

(SGM Southcrete Spray Deck textured coating)

10610 - Folding Gates

(Acorn Wire and Iron; pantographic action gates)

11476 - Revolving Darkroom Doors

(Regal Photo, steel and ABS)

11483 - Swimsuit Water Extractors (Suitmate)

15062 - Non-Penetrating Portable Rooftop Supports and
Walkways (Portable Pipe Hanger, Inc.)

15705 - Mini-Duct HVAC System (Unico, 2-inch diameter
duct system, air handler, duct heaters and coils)

15751 - Dehumidifiers (Air Technology Systems, silica gel
desiccant dehumidifiers)

Contributor Rewards:

As of this update, we are instituting a program to reward
subscribers who contribute sections that are added to the
SpecLink database. Any subscriber firm may offer sec-
tions they have created for consideration as new sections.
If we accept a subscriber’s contribution and add it to the
database, the subscriber will receive a full 3-month exten-
sion on their subscription. One submission at a time will
be considered, with a maximum of one accepted section
per quarter. Submissions of other than whole sections,
such as substantial additions or improvements to SpecLink
sections, will also be considered on a case-by-case basis.
All topics not currently included in the database are candi-
dates. We also consider how likely it is that other users will
benefit from the added sections. Contributed sections will
be added to our regular updating workload. For more
information and a list of sections people have asked for,
please email Susan McClendon at
smcclendon@bsdsoftlink.com.

Il..Export to RTF Now Includes Headers and Footers..!!
This update includes two long-awaited improvements to
the Export to RTF function — header/footer export and
individual file export

Individual File Export: ~ When exporting, you have the
option to export a single section, a whole Division, or the
whole project. In order to accommodate headers and
footers, the software has been changed to automatically
create individual files for each section no matter how many
sections are being exported. The section files are named
using the 5-digit section number plus the acronym, with the
extension .rtf. Because every project can have sections
with the same file names, it is important to export each
project to a separate directory. After you select the sec-
tions to export, you will be asked for a path — a drive and
directory. If the directory where you want all the exported
files to be saved does not yet exist, just type the full path
and the software will create it. It is no longer possible to
export the whole project to a single file. If you need to
store a project as a single file, such as for archive pur-
poses, you can use compression software such as PKZip
or WinZip to compress all the sections into a single file,
which has the added advantage of being a much smaller
file.

Headers and Footers: Exported sections now contain the
same headers and footers as sections printed from
SpecLink. All the keywords can be used as well as three
lines of text in each of three sections — left, right, and
center. There has been no change in how headers and
footers are set up — just go to the Format menu and select
Header and Footer, or select Page Setup from the File
menu or Print dialog box. After you have defined the
contents of the header/footer it is a good idea to preview or
print a section to confirm the layout. Then you should do a
test export and open the exported file in your word proces-
sor to confirm that the word processor interprets the RTF
codes correctly. The following describes some header/
footer layout considerations in SpecLink and in exported
files.

Long Project Names and Section Titles: In SpecLink
printed sections, text in the left/right/center sections can
overlap if it's too long. That often happens when using the
keywords for the project name or section title. If you are
using these keywords, the only solution is to stagger the
information on different lines so that the text doesn’t
actually overlap. For instance, if you wanted to print the
section title in the center section, you could avoid overlap-
ping by putting the section title on the first line and the text
or keywords of the left and right sections on the second
line. To prevent a long project name from overlapping you
can use typed text instead of the keyword. That allows you
to control the point at which the name breaks to a new line
— just type what fits on the first line, enter a carriage return



(press Enter) and type the remainder on the next line. All
this about long names is even more important when
exporting because there is no word wrap within the header/
footer sections in RTF files. The exported files use a
center tab to center the text in the middle section and a
right tab to right justify the right-hand section — if there isn’t
enough room the right-hand section will be bumped to the
next line.

New Tools for Adding Your Own Sections:

As anyone who has tried to import whole sections into

SpecLink can tell you, the process is fast but the result

may be less than spectacular if the import file contains

unnecessary codes or is not properly indented. In addition,
the most common method of indenting paragraphs in

Microsoft Word is not recognized by SpecLink’s Import

from Clipboard function. Now we have available a set of

macros that help get Word97 files properly formatted,
reducing the amount of cleanup required after importing.

What the macros will do:

* add tabs to properly indent files using styles assigned
to each paragraph (some files, including those format-
ted like AIA Masterspec® files, already have styles
assigned to each paragraph, which makes this process
much easier).

e remove notes to the editor that have a style assigned.

* remove either I-P or metric units if they are properly
color-coded.

The instructions accompanying the macros explain the
other formatting operations you will still have to do
manually, including:

» Assign the appropriate default style to each paragraph.

e Check for paragraphs missing paragraph marks,
correct, and assign the correct style.

* Remove text paragraph numbers.

* Remove bullets.

e Scan the file for special characters and symbols and
change them.

 Remove embedded (“bracketed”) choices within
paragraphs.

* Review the resultant file for inconsistencies and
correct.

» Add embedded choices to the imported text.

These macros are for Microsoft Word97 and are not

compatible with earlier versions of Word. To obtain the

macros and instructions, just email Support at
support@bsdsoftlink.com.

WordPerfect: Since WordPerfect indent codes and tabs
are correctly recognized by the SpecLink Import from
Clipboard function, it is unlikely that this procedure would
be necessary for WordPerfect files. If you have
WordPerfect 5.1 for DOS files, you will need a Windows
version of WordPerfect to take advantage of the Import
from Clipboard function. (Although Word97 will convert
WordPerfect 5.1 files, it will convert them the Word way,
making it necessary to do the reformatting that the above
macro procedure describes.)

Importing From Clipboard:

When you've finished formatting the Word97 file, you will

import it into a user-added section created in SpecLink.

The following is our suggested procedure for importing a

complete section:

1. Create a new section in your SpecLink project using
the New Section procedure; give it the Section number
00998 (or any other unique number).

2. Delete PARTS 1, 2, and 3 from the new section.
(Demote PART 2 and PART 3 below PART 1, and then
delete PART 1.)

3. Close the section — this is your “Blank Section” for
importing purposes.

4. Copy the Blank Section to the desired section number
for the imported section.

5. Open Word at the same time and open the section to
be imported.

6. Inthe Word file, block the entire text from PART 1 to

just above End of Section.

Press the Copy button or Ctrl-C.

Switch to SpecLink.

9. Place your cursor on END OF SECTION in the new
section.

10. Press the Import from Clipboard button on the toolbar
or select Tools/Import From Clipboard.

© N

The whole text that you blocked in Word will be inserted
between the Title of the section and End of Section, with
one paragraph to a cell. Check the hierarchy levels (left of
the status boxes). If the levels are 1, 2, 3, 4, etc., the
preparation for import was correct. If the levels are all
level 1, there were no tabs at the beginning of paragraphs.
Unless the section is very short, it will be less time-con-
suming to start over, rather than demote all the para-
graphs.

Specifier’'s Basic Library:

Both experienced and novice specifiers are likely to find
something useful in BSD’s Specifier’s Basic Library docu-
ment. It describes the principal sources of information on
specification writing practices, standard contract forms,
design-build specifying, metric practice, building product
information, and reference standards. Addresses, phone
numbers, and prices are included. To obtain the current
copy, just email Support at support@bsdsoftlink.com

Notice of Subscription Price Change:  Effective May 1,
2000, all multi-user subscription renewals will be invoiced
on the basis of the actual number of concurrent users
installed, instead of at a fixed price. To receive a quotation
or to adjust your firm’s number of concurrent users, please
contact your sales representative at 1-888-BSD-SOFT.




Support
cont. from page 1

are about to learn.
Then try to use your
new skills on a project
as soon as possible to
reinforce those les-
sons. After you have
had a chance to try
things on your own
you will probably
come up with a list of
further questions. Use
your second coupon
to get these answered
and learn some other
software tips.

BSD Support and Training: Beth Newman, Rick Crider, Laurie

Sometimes you may
want more in-depth
instruction or you don't
feel comfortable
learning things on
your own. Then you
will be spending time
with either Rick or Su-
san, trainers for cost
estimating and speci-
fications products.
BSD offers monthly
training classes in our
facility in Atlanta, or
we can come on-site.
All of our classes are
hands on and you get
the chance to create
a sample cost esti-
mate or project speci-
fication with all the re-

Newman, and Susan McClendon

Sales and Customer Service: (back) Jay Wendland, Karen
Stewart, Lee Altman, (front) Marjorie Boyd, and David Rogers

quired elements start

to finish. Please refer to the training
schedule on the back page of this news-
letter, or get the most up-to-date training
information on our website at
www.bsdsoftlink.com.

You have also probably spoken with one
of our sales/customer service repre-
sentatives. While you may cringe when
you hear that there is a sales person on
the line, you must also realize that our
sales people are an important resource
to you for finding solutions to your
automation problems. All of our sales
people go through our regular training
classes right along with new customers.
They get to hear what it is that customers
want to get out of the software, and also
unigue problems that customers are trying

to solve. Being immersed in the customer
training like this makes our sales people
sensitive to your needs and able to
suggest solutions, so treat them nicely
when they call!

And you don't have to take our word for it
when it comes to how great our
employees are. Listen to these
comments. “(She) has been an absolute
pleasure to work with. Her knowledge of
SpeclLink, positive attitude, quick
response times, and dependability have
been invaluable. She has consistently
helped me to meet my deadlines on time
and on budget.” “(He) was very good,
easy to follow, handles people well.” “The
hands-on was an excellent way to get
started using this software.”

Q&A
continued from page 2

you just call technical support (see ar-
ticle in this newsletter about how nice
and smart BSD’s tech support depart-
ment is) and they will tell you the simple
fix to get up and running again.

BSD CostLink (MFW)

| am having problems getting my

alternate cost titles to work cor-
rectly. It seems to be putting my base
bid and alternates in the wrong order.

We were not able to figure out

what was going wrong over the
phone, so we had the user email the
project to us. After we were able to look
at the project we could see that a space
(spacebar) was used as the first char-
acter in the Level 1 title ID, i.e. _1, 2,
_3, etc. The problem is that the soft-
ware does not read the space and sorted
the titles in the wrong order. Itis bestto
fill in all the characters in an ID using a
zero to fill in the preceding space if nec-
essary. So in the above example the
ID would be 01, 02, 03...

How do | convert my project from
English to Metric?

Before you do any estimate con-

versions, it is always recom-
mended that you make a copy first.
Then open your project and open the
Summary Information panel (the icon
that looks like a calculator). Click on
the Calculation tab and you will see three
buttons labeled Original Units, U.S.
Units, and Metric Units. Click on Metric
Units and then press the OK button. You
will be prompted to confirm that you
want your project updated to the new
units. The software will go through each
line item and convert the quantity and
cost based on its own internal conver-
sion table. An alternate to permanently
changing the units of a project is to se-
lect Metric Units before a report is
printed. The calculation is the same but
it is not stored in the project.

BSD SpecLink/+(beta)

We have created an office master
that is the base for all our projects.

See Q&A, page 6




Q&A
continued from page 5

When the new version of SpecLink is
implemented, will we be able to have
our present office master integrate into
the new format without having to do a
lot?

Never fear, when we roll out the

new version of SpecLink it will
include a translator that will update all
existing projects, including office master
projects, to the new format.

Remember: Test projects created

using the beta software may not
be compatible with the final production
release.

BSD SpecLink

| would like to add some key

requirements to several sections
and have them print out on the require-
ments report. Can | do that?

You can add requirements that will

show up on the requirements
report, you just can’t add them to the
project screen so that they show as
buttons. To see the available require-
ments and their 2 character ID’s, look
at the buttons on the project screen.
You will see requirements such as PD —
Product Data and SD - Shop Drawings.
Now go back into your section and add
a paragraph regarding the new
requirement. From the View menu
select Status Columns and then Tag
Column. This will open up a column of
Tag ID’s, most of them N/A. Enter the 2
character ID of the requirement in the
Tag column next to that paragraph.

How do | get the Division number

and name into my section
heading along with the Section name
and number?

When you set up your project’s

headers and footers from the
Page Setup screen, you are making
selections for the whole project. If you
simply add a division description like
“Division 8: Doors and Windows” to the
header, it will print on every section,
regardless of the actual division. There
are several ways around this. If this is
a one-time requirement, you might add

the division name as described above
and simply print one division at a time,
changing the division numbers for each
group. This would take a little time and
a few steps but it works. If you want the
Division numbers to print on every
project you do, then you can add them
to each section in your office master.
Highlight the Part 1 paragraph and insert
a new paragraph. Type in the Division
number and description. You will
probably want to add another paragraph
and add the Section number and
description also.

We are really sold on SpecLink,

but we have hundreds of existing
spec sections contained in numerous
word processing programs. Cutting and
pasting into the master is going to take
forever.

We are glad you are sold on

SpecLink and we are sure that you
will be happy with your purchase. When
starting out, it is important to remember
that your office master is like an overlay
with the SpecLink master data
underneath. In order to take full
advantage of SpecLink’s unique
updating capability it is best to first look
for existing SpecLink master sections
which closely resemble your own
sections. Selections, fill-ins, and
additions can be made to edit your office
master to match your current word
processing sections. This way, every
time you get your quarterly update,
these sections will be automatically
updated without changing any of your
selections or deleting any of your
additions. If you have a very specialized
or unique spec section and you have
determined that there are no SpecLink
master sections that match it, then you
can import that section in its entirety.
This is much faster than cutting and
pasting individual paragraphs.

HINT —many problems are caused

by having insufficient disk space.
Sometimes this will manifest in difficulty
making choices or adding text, and
sometimes it's problems with printing.
Your computer uses free disk space for
many internal functions so it is important
not to run too low. Your Windows User
Manual can give you information about
how much free disk space you need.

Training Schedule

BSD SpecLink

1-1/2 day $395

February 28 - 29

March 27 - 28

April 24 - 25

May 22 - 23

June 19 - 20

July 17 - 18

August 28 - 29

September 18 - 19

October 23 - 24

November 13 - 14
December 11 - 12

*Class attendees earn 12 AIA
Learning Unit Hours, all of
which qualify for HSW hours.

BSD CostLink/CM (M32)*
3-1/2 days $1095

*please note that this is changed
March 21 - 24

April 11 - 14

May 9 - 12

June 13 - 16

July 11 - 14

August 22 - 25

September 12 - 15

October 17 - 20

November 7 - 10

December 5 - 8

*Many states allow related
training courses to meet
Continuing Professional
Competency requirements.
Please check with your state
licensing board for specific
requirements.

*Government Contractors
earn Mcaces Certification.

BSD CostLink (MFW)

-this class is no longer offered on
a regular basis. Please call if you
have a need.

You can now look for BSD class
schedules on our internet site.
Just go to www.bsdsoftlink.com
and go to the training page.
You will find schedules, maps,
hotel infor-
mation, and
_information
W about
Atlanta.




